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Introduction
Simplify
Reference
Menu: Properties editor ‣ Scene ‣ Simplify

Texture Limit
Automatically scales textures down textures so they are no larger than the values chosen. This can help
large scenes that use huge textures to still fit into the computer’s memory resources.
Use Camera Cull
Automatically culls objects based on the camera frustum defined by the Margin.
Use Distance Cull
Automatically culls objects based on their distance from the active camera. This is set via the Distance
property.

Integrator
The integrator is the rendering algorithm used to compute the lighting. Cycles currently supports a path tracing
integrator with direct light sampling. It works well for various lighting setups, but is not as suitable for caustics
and some other complex lighting situations.
Rays are traced from the camera into the scene, bouncing around until they find a light source such as a lamp,
an object emitting light, or the world background. To find lamps and surfaces emitting light, both indirect light
sampling (letting the ray follow the surface BSDF) and direct light sampling (picking a light source and tracing
a ray towards it) are used.

Sampling
Reference
Panel: Properties editor ‣ Render ‣ Sampling
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Sample Method
There are two integrator modes that can be used: Path Tracing and Branched Path Tracing.
Square Samples
Square the amount samples.
Seed
Seed value for integrator to get different noise patterns.
Animate Seed (clock icon)
This button which can be found on the right side of the Seed value can be used to give different seed
values. It is a good idea to enable this when making animation because in the real world each frame
has a different noise pattern.
Clamp Direct
This option limits the maximum intensity a sample from rays which have not yet bounced can contribute
to a pixel. It reduces noise at the cost of accuracy. Setting this option to 0.0 disables clamping altogether.
Lower have a greater affect (dimmer samples) on the resulting image than higher values.
Note
A common issue encountered with Path Tracing is the occurrence of “fireflies”: improbable samples that
contribute very high values to pixels. This option provides a way to limit that. However, note that as you
clamp out such values, other bright lights/reflections will be dimmed as well.
Care must be taken when using this setting to find a balance between mitigating fireflies and losing
intentionally bright parts. It is often useful to clamp indirect bounces separately, as they tend to cause
more fireflies than direct bounces. See the Clamp Indirect setting.

Clamp Indirect
The same as Clamp Direct, but for rays which have bounced multiple times.
Light Sampling Threshold
Probabilistically terminates light samples when the light contribution is below this threshold (more noise
but faster rendering). Zero disables the test and never ignores lights. This is useful because in large scenes
with many light sources, some might only contribute a small amount to the final image, and increase
render times. Using this setting can decease the render times needed to calculate the rays which in the end
have very little affect on the image.
Pattern
Random sampling pattern used by the integrator.
Sobol
Uses a Sobol pattern to decide the random sapling pattern used by the integrator. See Sobol
sequence on Wikipedia for more information.
Correlated Multi-Jitter
Uses a Correlated Multi-Jitter pattern to decide the random sapling pattern used by the integrator.
See this Pixar paper for more information.
Layer Samples
When render layers have per layer number of samples set, this option specifies how to use them.
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Use
ToDo
Bounded
Bound render layer samples by scene samples.
Ignore
Ignore render layer sample settings.

Path Tracing
The Path Tracing integrator is a pure path tracer; at each hit it will bounce light in one direction and pick one
light to receive lighting from. This makes each individual sample faster to compute, but will typically require
more samples to clean up the noise.
Render Samples
Number of paths to trace for each pixel in the final render. As more samples are taken, the solution
becomes less noisy and more accurate.
Preview Samples
Number of samples for viewport rendering.

Branched Path Tracing
The non-progressive Branched Path Tracing integrator offers finer control over sampling. It is similar to Path
Tracing, but at the first hit it will split the path for different surface components and will take all lights into
account for shading instead of just one.
This makes each sample slower, but will reduce noise, especially in scenes dominated by direct or one-bounce
lighting. To get the same number of diffuse samples as in the path tracing integrator, note that e.g. 250 path
tracing samples = 10 AA samples x 25 diffuse samples. The Sampling panel shows this total number of
samples.
AA Render Samples
Number of samples to take for each pixel in the final render. More samples will improve antialiasing.
AA Preview Samples
Number of samples for viewport rendering.
Diffuse Samples
Number of diffuse bounce samples to take for each AA sample.
Glossy Samples
Number of glossy bounce samples to take for each AA sample.
Transmission Samples
Number of transmission bounce samples to take for each AA sample.
AO Samples
Number of ambient occlusion samples to take for each AA sample.
Mesh Light Samples
Number of mesh light samples to take for each AA sample.
Subsurface Samples
Number of subsurface scattering samples to take for each AA sample.
Volume Samples
Number of volume scattering samples to take for each AA sample.
Sample All Direct Lights
When enabled, Cycles will samples all lights in the scene for direct bounces, instead of randomly picking
one. Disabling this can improve performance, when using a lot of AA Samples anyway, to clear up the
render.
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Sample All Indirect Lights
Similar to direct light, but for indirects lights. This can reduce noise in scenes with many lights.

Light Paths
Reference
Panel: Properties editor ‣ Render ‣ Light Paths

Bounces
Max Bounces
Maximum number of light bounces. For best quality, this should be set to the maximum. However, in
practice, it may be good to set it to lower values for faster rendering. Setting it to maximum 0 bounces
results in direct lighting only.
Min Bounces
Minimum number of light bounces for each path, after which the integrator uses Russian Roulette to
terminate paths that contribute less to the image. Setting this higher gives less noise, but may also
increase render time considerably. For a low number of bounces, it is strongly recommended to set this
equal to the maximum number of bounces.
Diffuse Bounces
Maximum number of diffuse bounces.
Glossy Bounces
Maximum number of glossy bounces.
Transmission Bounces
Maximum number of transmission bounces.
Volume Bounces
Maximum number of volume scattering bounces.

Transparency
Transparency Max
Maximum number of transparency bounces.
Transparency Min
Minimum number of transparency bounces, after which Russian Roulette termination is used.
Transparent Shadows
For direct light sampling, use transparency of surfaces in between to produce shadows affected by
transparency of those surfaces.

Caustics & Filter Glossy
Reflective Caustics
While in principle path tracing supports rendering of caustics with a sufficient number of samples, in
practice it may be inefficient to the point that there is just too much noise. This option can be unchecked,
to disable reflective caustics.
Refractive Caustics
The same as above, but for refractive caustics.
Filter Glossy
When using a value higher than 0.0, this will blur glossy reflections after blurry bounces, to reduce noise
5
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at the cost of accuracy. 1.0 is a good starting value to tweak.
Some light paths have a low probability of being found while contributing much light to the pixel. As a
result these light paths will be found in some pixels and not in others, causing fireflies. An example of
such a difficult path might be a small light that is causing a small specular highlight on a sharp glossy
material, which we are seeing through a rough glossy material. In fact in such a case we practically have a
caustic.
With path tracing it is difficult to find the specular highlight, but if we increase the roughness on the
material, the highlight gets bigger and softer, and so easier to find. Often this blurring will hardly be
noticeable, because we are seeing it through a blurry material anyway, but there are also cases where this
will lead to a loss of detail in lighting.

Geometry
Reference
Panel: Properties editor ‣ Render ‣ Geometry

Volume Sampling
Step Size
Distance between volume shader samples when rendering the volume. Lower values give more accurate
and detailed results but also increased render time.
Max Steps
Maximum number of steps through the volume before giving up, to protect from extremely long render
times with big objects or small step sizes.

Subdivision Rate
These settings are used to control the True Displacement.
Note
These Options are only available if Experimental Feature Set is turned on.

Render
Size of micropolygons in pixels.
Preview
Size of micropolygons in pixels while preview rendering.
Max Subdivisions
Stop subdividing when this level is reached even if the dice rate would produce finer tessellation.

Hair
These are global settings that apply to all instances of hair systems. The resolution of the strands is controlled
by the step values in particle settings. Each hair system uses the material identified in the particle settings in the
same way as Blender Internal.
Use Hair
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Enables rendering of hair particle systems.
Primitive
Triangles
Uses a triangle mesh.
Resolution
ToDo.
Line Segments
Uses a straight curve primitive.
Curve Segments
Uses a smooth Cardinal curve primitive. These interpolate a path through the curve keys. However,
it renders slower than line segments.
Curve Subdivisions
The interpolated path is subdivided to give points to connect. The parameter subdivisions sets
the number of divisions used.
Shape
Thick
Cylindrical segments between two points.
Cull back-faces
Excludes strands emitted from the mesh back facing the camera.
Ribbons
Are flat planes following the strand direction facing the camera.
Min Pixels
Strands that are further away will be made wider, which is compensated with transparency to keep the
look similar. This effect is only applied for camera rays. It works best with ribbon primitives.

Light Paths
Ray Types
Ray types can be divided into four categories:
•
•
•
•

Camera: the ray comes straight from the camera.
Reflection: the ray is generated by a reflection off a surface.
Transmission: the ray is generated by a transmission through a surface.
Shadow: the ray is used for (transparent) shadows.

Reflection and transmission rays can further have these properties:
• Diffuse: the ray is generated by a diffuse reflection or transmission (translucency).
• Glossy: the ray is generated by a glossy specular reflection or transmission.
• Singular: the ray is generated by a perfectly sharp reflection or transmission.
The Light Path node can be used to find out the type of ray the shading is being computed for.
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Bounce Control
The maximum number of light bounces can be controlled manually. While ideally this should be infinite, in
practice a smaller number of bounces may be sufficient, or some light interactions may be intentionally left out
for faster convergence. The number of diffuse reflection, glossy reflection and transmission bounces can also be
controlled individually.
Light paths are terminated probabilistically when specifying a minimum number of light bounces lower than
the maximum. In that case paths longer than minimum will be randomly stopped when they are expected to
contribute less light to the image. This will still converge to the same image, but renders faster while possibly
being noisier.
A common source of noise is caustics, which are diffuse bounces followed by a glossy bounce (assuming we
start from the camera). An option is available to disable these entirely.

Transparency
The transparent BSDF shader is given special treatment. When a ray passes through it, light passes straight on,
as if there was no geometry there. The ray type does not change when passing through a transparent BSDF.
Alpha pass output is also different for the transparent BSDF. Other transmission BSDFs are considered opaque,
because they change the light direction. As such they cannot be used for alpha-over compositing, while this is
possible with the transparent BSDF.
The maximum number of transparent bounces is controlled separately from other bounces. It is also possible to
use probabilistic termination of transparent bounces, which might help rendering many layers of transparency.
Note that while semantically the ray passes through as if no geometry was hit, rendering performance is
affected as each transparency step requires executing the shader and tracing a ray.

Ray Visibility
Objects can be set to be invisible to particular ray types:
•
•
•
•
•

Camera
Diffuse reflection
Glossy reflection
Transmission
Shadow

Properties Editor Object ‣ Cycles Settings ‣ Ray visibility.
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This can be used, for example, to make an emitting mesh invisible to camera rays. For duplicators, visibility is
inherited; if the parent object is hidden for some ray types, the children will be hidden for these too.
In terms of performance, using these options is more efficient that using a shader node setup that achieves the
same effect. Objects invisible to a certain ray will be skipped in ray traversal already, leading to fewer rays cast
and shaders executed.

Motion Blur & Film
Motion Blur
Reference
Panel: Properties editor ‣ Render ‣ Motion Blur

Blender’s animations are by default rendered as a sequence of perfectly still images. While great for stopmotion and time-lapses, this is unrealistic, since fast-moving objects do appear to be blurred in the direction of
motion, both in a movie frame and in a photograph from a real-world camera.

Cycles Motion Blur Example.
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Note
If there are particles or other physics system in a scene, be sure to bake them before rendering, otherwise you
might not get correct or consistent motion.

Options

Cycles Motion Blur Settings.
Position
Controls at what point the shutter opens in relation to the frame.
• End on frame
• Center on frame
• Start on frame
Shutter Speed
Time between frames over which motion blur is computed. Shutter time 1.0 blurs over the length of 1
frame, 2.0 over the length of two frames, from the previous to the next.
Shutter Curve
Curve defining how the shutter opens and closes.
Shutter Type
Replicates CMOS cameras by rendering a rolling shutter effect using scanlines.
• Top Bottom: Renders rolling shutter from the top of the image to the bottom.
Rolling Shutter Duration
Controls balance between pure rolling shutter effect and pure motion blur effect. With zero being no
rolling shutter and one being all rolling shutter.
Warning
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An object modifier setup that changes mesh topology over time will cause severe problems.
Common examples of this are animated Booleans, Deformation before Edge Split, Remesh, Skin or Decimate
modifiers.

Each object has its own settings to control motion blur. These options can be found in the Object tab of the
Properties editor.

Film
Reference
Panel: Properties editor ‣ Render ‣ Film

Exposure
This can be used to change the brightness of an image. Different then the Exposure option found in the
Color management panel this exposure option works is on the data while the Color management exposure
is on the view.
Transparent
ToDo
Pixel Filter
Blackman-Harris, Box, Gaussian
Width
ToDo.

Performance
Threads
Mode
Auto-detect
Automatically chooses the amount threads to match the number of logical processors on your
computer.
Fixed
Manually choose the amount threads to use for rendering. This can be useful for example, if you
want to use your computer while rendering you can set the property to a thread count lower the
amount of logical processors on your computer.

Tiles
Tile Order
Order of rendering tiles. This does not significantly affect performance.
Tile size X/Y
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The size of the tiles for rendering.
Depending on what device you are using for rendering, different tile sizes can give faster renders. For
CPU rendering smaller tiles sizes (like 32 x 32) tend to be faster, while for GPU rendering larger tile sizes
give better performance (like 256 x 256).
Progressive Refine
Instead of rendering each tile until it has finished every sample, refine the whole image progressively.
Note that progressive rendering is slightly slower than tiled rendering, but time can be saved by manually
stopping the render when the noise level is low enough.
For rendering animations it is best to disable this feature, as stopping a frame early is not possible.
Save Buffers
Saves all render layers and passes to the temp directory on a drive, and read them back after rendering has
finished. This saves memory usage during rendering, particularly when using many render layers and
passes.

Viewport
Viewport BVH Type
Dynamic BVH
Objects can be transformed, added and deleted interactively, at the cost of slower renders.
Static BVH
Object modifications require a complete BVH rebuild which reduces interactivity but renders faster.
Start Resolution
Resolution to start rendering preview at, progressively increase it to the full viewport size.

Final Render
Persistent Images
Keep image data in memory after rendering, for faster re-renders at the cost of extra memory usage when
performing other tasks in Blender.

Acceleration Structure
Use Spatial Splits
Spatial splits improve rendering performance in scenes with a mix of large and small polygons. The
downsides are longer BVH build times and slightly increased memory usage.
Use Hair BVH
Use a special type of BVH for rendering hair. The bounding boxes are not axis aligned allowing a
spatially closer fit to the hair geometry. Disabling this option will reduce memory, at the cost of
increasing hair render time.

Layers
Reference
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Panel: Properties editor ‣ Render Layers ‣ Layer

This section covers only the Render Layer settings appropriate for the Blender Render engine. For the engineindependent settings, see this section.
Exclude
Scene layers are shared between all render layers; however, sometimes it is useful to leave out some
object influence for a particular render layer. That is what this option allows you to do.
Material
Overrides all materials in the render layer.
Samples
Render layer samples to override the scene samples. Controlled by the layer samples in the sampling
panel.
Use Environment
Disables rendering the Environment render pass in the final render.
Use AO
Disables rendering the Ambient Occlusion render pass in the final render.
Use Surfaces
Disables rendering object materials in the final render.
Use Hair
Disables rendering hair strands in the final render.

Passes
Reference
Panel: Properties editor ‣ Render Layers ‣ Passes

Passes can be used to split rendered images into colors, direct and indirect light to edit them individually, and
also to extract data such as depth or normals.

Lighting Passes
Diffuse Direct
Direct lighting from diffuse BSDFs. We define direct lighting as coming from lamps, emitting surfaces,
the background, or ambient occlusion after a single reflection or transmission off a surface. BSDF color is
not included in this pass.
Diffuse Indirect
Indirect lighting from diffuse BSDFs. We define indirect lighting as coming from lamps, emitting
surfaces or the background after more than one reflection or transmission off a surface. BSDF color is not
included in this pass.
Diffuse Color
Color weights of diffuse BSDFs. These weights are the color input socket for BSDF nodes, modified by
any Mix and Add Shader nodes.
Glossy Direct, Indirect, Color
Same as above, but for glossy BSDFs.
Transmission Direct, Indirect, Color
Same as above, but for transmission BSDFs.
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Subsurface Direct, Indirect, Color
Same as above, but for subsurface BSDFs.
Emission
Emission from directly visible surfaces.
Environment
Emission from the directly visible background. When the film is set to transparent, this can be used to get
the environment color and composite it back in.
Shadow
Shadows from lamp objects. Mostly useful for compositing objects with shadow into existing footage.
Ambient Occlusion
Ambient occlusion from directly visible surfaces. BSDF color or AO factor is not included; i.e. it gives a
‘normalized’ value between 0 and 1.

Note
Transparent BSDFs are given special treatment. A fully transparent surface is treated as if there is no surface
there at all; a partially transparent surface is treated as if only part of the light rays can pass through. This
means it is not included in the Transmission passes; for that a glass BSDF with index of refraction 1.0 can be
used.

Combining
All these lighting passes can be combined to produce the final image as follows:
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Data Passes
Combined
The final combination of render passes with everything included.
Z
Distance in BU to any visible surfaces.
Note
The Z pass only uses one sample. When depth values need to be blended in case of motion blur or DOF,
use the mist pass.
Mist
Distance to visible surfaces, mapped to the 0.0-1.0 range. When enabled, settings are in World tab. This
pass can be used in compositing to add fade out object that are further away.
Normal
Surface normal used for shading.
Vector
Motion vectors for the vector blur node. The four components consist of 2D vectors giving the motion
towards the next and previous frame position in pixel space.
UV
Default render UV coordinates.
Object Index
Creates a mask of the object that can be later read by the ID Mask Node in the compositor.
Material Index
Creates a mask of the material that can be later read by the ID Mask Node in the compositor.
Note
The Z, Object Index and Material Index passes are not anti-aliased.

Alpha Threshold
Z, Index, normal, UV and vector passes are only affected by surfaces with alpha transparency equal to or
higher than this threshold. With value 0.0 the first surface hit will always write to these passes, regardless
of transparency. With higher values surfaces that are mostly transparent can be skipped until an opaque
surface is encountered.

Denoising
Reference
Panel: Properties editor ‣ Render Layers ‣ Denoising

Denoising filters the resulting image using information (known as feature passes) gathered during rendering to
get rid of noise while preserving visual detail as well as possible.
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To use the option, enable it in the render layers tab of the properties editor. On rendering, it will denoise tile by
tile once all the surrounding tiles are finished rendering. The default settings fit a wide range of scenes, but the
user can tweak individual settings to control the tradeoff between a noise-free image, image details, and
calculation time.
See also
See the other ways to reduce noise on the general Noise Optimization page.

Options

Denoising panel.
Radius
Size of the image area that’s used to denoise a pixel. Higher values are smoother, but might lose detail
and are slower.
Strength
Controls how different the area around a neighbor pixel can look compared to the center pixel before it’s
no longer used for denoising. Lower values preserve more detail, but aren’t as smooth.
Feature Strength
Controls removal of noisy and redundant image feature passes before the actual denoising. This is
required in some cases like DoF or Motion Blur to avoid splotchy results, but might cause fine
texture/geometrical detail to be lost. Lower values preserve more detail, but aren’t as smooth.
Relative Filter
When removing features that don’t carry information, decide which to keep based on the total amount of
information in the features. This can help to reduce artifacts, but might cause detail loss around edges.
Passes
You can choose to selectively choose which Render Passes you want to denoise.

Notes and issues
The denoiser will change in the future and some features are not implemented yet. If denoising fails to produce
good results, more samples or clamping will often resolve the issue.
• Setting the radius too high is generally not advisable. It increases denoising time a lot and, while the
result might be smoother, it is not more accurate since there isn’t any additional info coming out of the
renderer. Beyond a radius of ~15, the additional rendering time is probably better spent on increasing the
amount of samples.
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• Denoising cannot be used for baking yet.
• For animation denoising can be used, however it still requires high sample counts for good results. With
low sample counts low frequency (blurry) noise can be visible in animation, even if it is not immediately
apparent in still images.
• When using GPU rendering, the denoising process may use a significant amount of vRAM. If the GPU
runs out of memory but renders fine without denoising, try reducing the tile size.

Examples
Below is an example render by The Pixelary.

Example render before denoising.

Example render after denoising.

Object Data
Motion Blur
Reference
Panel: Properties editor ‣ Object ‣ Motion Blur

Each object has its own motion blur settings along with the Scene Level Motion Blur These settings can be
found in the Object Properties tab of the Properties editor.
Deformation
Enables motion blur for deformed meshes such as animated characters, including hair.
Steps
Controls accuracy of deformation motion blur, more steps gives more memory usage. The actual number
of time steps is 2steps−1
.
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Cycles Settings
Ray Visibility
Camera
Makes the object visible in camera rays.
Diffuse
Makes the object visible in diffuse rays.
Glossy
Makes the object visible in glossy rays.
Transmission
Makes the object visible in transmission rays.
Volume Scatter
Makes the object visible in transmission rays.
Shadow
Enables the object to cast shadows.
Shadow Catcher
Enables the object to only receive shadow rays. It is to be noted that shadow catcher objects will interact
with other CG objects via indirect light interaction. This feature makes it really easy to combine CGI
elements into a real-life footage.

Example of the shadow catcher. Note how the material of the plane can still be viewed in the spheres.

Performance
Use Camera Cull
TODO.
Use Distance Cull
TODO.

Adaptive Subdivision
Note
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Implementation not finished yet, marked as an Experimental Feature Set

When using the Experimental Feature Set the Subdivision Surface Modifier gets changed to control the
subdivision of a mesh at the time of rendering. For this, all the other settings are the same except the View and
Render settings. These previously mentioned settings get removed/renamed and the following settings are
added:

Subdivision Surface Modifier.
Preview
Levels
The levels of subdivision to see in the 3D View, this works the same as the View setting on the original
Subdivision Modifier.
Render
Adaptive
Use OpenSubdiv to give different subdivision levels to near and far objects automatically. This allows
nearer object to get more subdivisions and far objects to get less.
Dicing Rate
When using Adaptive the Render Levels property gets changed to Dicing Rate, this property is used
to multiply the scene dicing rate.
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Subdivision Off/On, Dicing Rate: 1.0 - 0.3 - 0.05 (Monkeys look identical in viewport, no
modifiers).
Levels
The levels of subdivision to see in the final render, this works the same as the Render setting on the
original Subdivision Modifier.

Known limitations
• Missing support for UV subdivision.
• Creases do not match Blender creases currently.
• Multi-user object data are currently made single users, leading to increased memory usage. For those it
is better to use non-adaptive subdivision still.
• Multi-view renders can have some inconsistencies between views.
• Editing displacement shaders while using True Displacement does not update the viewport.
Warning
Particle instances, Group instances, Dupliverts and Dupligroups are not tessellated individually. Instead, the
original object is tessellated and then duplicated on all instances. To take advantage of both adaptive
subdivision and instancing you should place the original object at the position of the instance that is closest
from the camera.

Hair Particles
These are extra settings for Hair Particles used by Cycles.
There are also scene level hair settings which can be found with the Geometry settings.

Hair Settings
The Cycles Hair Settings, under the particle tab, are used to control each hair particle system’s strand
properties.
Shape
A shape parameter that controls the transition in thickness between the root and tip. Negative values make
the primitive rounded more towards the top, the value of zero gives makes the primitive linear, and
positive values makes the primitive rounded more towards the bottom.

Thickness
Root
Multiplier of the hair width at the root.
Tip
Multiplier of the hair width at the tip.
Scaling
Multiplier for the Root and Tip values. This can be used to change the thickness of the hair.
Close tip
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Sets the thickness at the tip to zero, even when using a non-zero tip multiplier.

Texture
ToDo
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